
1 Doon International School, Srinagar 

 

              DOON INTERNATIONAl SCHOOL,SRINAGAR 

SUBJECT – Computer  

Assignment:II 

   Grade:VI                              

Chapter:- Microsoft  Powerpoint  2007 
 

• The objective of this assignment  is to make the students get acquainted with new features of 

Microsoft Power Point 2007 and how to use table and chart formatting tools in it. 
 

Microsoft power point is a powerful tool which helps us to communicate our views and ideas effectively  

Using diagrams, photos, clip arts, sounds, colours, designs and animated special effects. 

 

Power point provides additional features to organize the information in a tabular format. In this 

assignment we will learn about :- 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Table :-A table is a grid of cells arranged in rows and columns.  

Inserting a table 

Entering Data in table 

Formatting a Table style 

Charts in Power Point  

Components of Charts 

Creating, Changing and 

Formatting a chart 
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Inserting A table:- 

• To insert a table, Click on New slide drop-down arrow on the Home Tab. Select the Title and 

content layout.  

• Click the Insert table command present on the slide. The Insert Table dialog box will appear.  

• Define the number of rows and columns and click on OK. 

• A table will be displayed according to the defined rows and columns. 

 

OR 

• We can insert a table in a slide by clicking on the Table Option on Insert tab. A menu will appear. 

• Drag the mouse over the diagram of Squares to select the number of columns and rows in the table. 

 

OR 

• Click on the Insert tab and select TABLE > Draw Table option to draw a table. 

 

Entering data in a table:- 

 

After inserting the table in a slide, we can insert now data in the table by using the Tab key or Arrow keys 

or Mouse. After typing the data in the table, We click on the grey area outside the slide. 

 

➢ To Edit Data in a table, Click on the cell to be modified and make changes in it. 

 

➢ To Insert new rows in a table: 

• Place the insertion point in a cell. 

• Click the right mouse button. 

• Select Insert option and click on either Insert rows Above or Insert Rows Below sub option .You 

can select any of the option from the Layout tab. 

 

➢ To apply different backgrounds colours:   

• Select the table by clicking on the outside border. 

• Click on Shading button  in the Design Tab. 

• Select a colour of your choice.  

To delete a row or column from a table, click on Delete button in the rows & columns group on the 

layout tab. Select the required option. 

 TABLE TOOLS:- 

When we Insert a table in power point 2007 a new tab  Tools Tab appears. We will find various number 

of tools present on its Design and Layout Tabs . 

 
 

 

 

 

              Formatting Table Tools 
 

Borders 
Split cells Shading Table styles 

Merge cells 
Draw table 
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Formatting A Table Style 

➢ Table styles  

When you insert a table, Power point automatically applies a table style to the table. You can view  the 

style options in the Table Styles group on the Design tab. 

• To apply a table style, first selected the table. 

• Click the Design tab to access all the table styles and options. 

• Point the cursor over a table style to see a live preview of the style on the slide. 

• Click the More drop-down arrow to view all the options. 

• Click on the desired style to select it.   

➢ To Apply A Border  

• Borders button on the Design tab is used to add border to a table in a variety of ways. 

• Select the rows or columns you want to modify. 

• Click the Borders tool in the Table Style group. Select All Borders option. 

 

➢ To change the thickness of the border line, click on the Pen Weight Tool in Draw Borders 

group. Select any border width from the drop-list. The pointer changes to pencil tool. Drag the 

pointer over the border line and release the button. 

 

Border STYLE  

Border style tool is very helpful in changing the line style of a table. 

• Select the table and click on Pen Style list box on the Design Tab. A drop down menu appears. 

Select the required style. The mouse pointer changes to pencil. 

• Place the mouse pointer on any line of the table and click on it or drag the mouse pointer over a 

line. Observe the change. 

Aligning the text 

Aligning refers to the positioning of text  in a table cell. Alignment is applied on the text entered in the 

cell. By default ,the text is aligned to the top of a cell. You  will find six alignments buttons on the layout 

tab i.e  Align Top, Center vertically, Align bottom etc. 

• Select any cell entry. 

• Click on the Align bottom button in the alignment group on Layout tab. Text will be aligned to 

the bottom of the cell.  

Charts In Power Point 

Chart is an effective way to display data in a pictorial form. Charts make it easier to show comparison and 

growth relationship among the values and trends in data. Charts provide an accurate analysis of the 

information. 
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When we insert a chart, the data is displayed   in a special window called Datasheet. A chart gets updated 

automatically with any changes in data. 

 

 

 

 

 

 

 

 

 

 

 

1.Chart Area:-The chart area includes the complete area and all the objects in a chart. 

2.Category Axis:-A category axis or X axis is the horizontal axis .the  matter that is compared and 

presented in the chart comes under it. 

3.Value Axis:-A Value axis or Y axis is the vertical axis which is used to plot the values. 

4.Data Series:- Data series are the bars ,slices or the other elements that show the data values. 

5.Category Name:-are the labels displayed on the  X and Y axis . 

6.Plot Area:- is window with in the chart area .it contains the actual chart itself and includes plot data, 
data series, category and value axis. 

7.Legend:- It depicts the colours, patterns or the symbols which are assigned to the data series. 

Creating A Chart 

To create a chart on a slide, follow these steps.  

• Click on the Layout button and select Title and content layout from the drop down menu. Select 

the “click  to add title” placeholder  and type  “Monthly stationary expenses”. 

• Click the insert chart icon on the slide. The insert chart dialog box appears. Click and drag the 

scroll bar to view the chart types, or click any label on the left of the dialog box to see a specific 

chart style. Select the Bar chart and click on OK. The chart will be displayed with a datasheet 

that contains the default data. 

• We can also enter our own data in the data sheet.  

Components Of A Chart 

Chart Area 

Category Axis 

Value Axis 

Data Series 

Category Name 

Plot Area 

Legend  
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We can also insert a chart in any slide by using Chart button, present on the insert tab.  

To make changes in chart data, right click on the chart and select Edit data option. Datasheet will open. 

Make changes in it and notice the effect. 

Deleting data from the datasheet. 

• To delete all the data from the datasheet, move the mouse pointer to the blank button . 

• The mouse pointer changes into a large plus sign of white colour. Click on the button .The entire 

datasheet will be selected .Press the Delete key. 

Changing The Chart Type 

• Select the chart, click on the design tab. 

• Click on Change Chart Type button in type  group on the design tab. The insert chart dialog box 

will appear. Select any chart type and click on OK . The chart will change into a new chart type. 

Formatting A chart 

Formatting improves the appearance of a chart we can format a chart to add title, change the text, font, 

line colour, Width, border style, Legends, Data series etc. When we insert a chart, three new tabs will 

appear on the ribbon .Design, Layout and format contain various chart tools and commands that allow 

you to modify and format the chart. 

 

Modifying The Chart Layout 

The chart layout determines how specific chart information will appear. To change the Chart layout: 

• Select the chart and click on the Design tab. 

• Scroll through the options in the chart layout group, or click the more drop down arrow to see all 

the chart layout options. 

• Select any chart , layout according to the need. 

 

On the basis of understanding of chapter answer the following questions.  

1.What is splitting of a cell? 

2.What is merge cell option used for? 

3.Differentiate between bar chart and column chart. 

4.How can you change the table shading. 

5.How can you change the colour and patterns of a chart . 

 

Practical work:- 

Your school has raised the fund from each class i.e first to tenth for the orphanage of town .Your teacher 

has given you responsibility to keep the record of this fund. Create a table in Power Point. And define the 

collection  from each class. Further covert the data into chart. 

 

Note :-Do all the textual and additional questions on fair notebook. 
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DOON INTERNATIONAL SCHOOL, SRINAGAR 

SUBJECT: ENGLISH 

ASSIGNMENT - II 

GRADE: VI  

 

 The objective of this assignment is to test student’s ability to grasp the meaning of a 

given passage properly and also to answer in one’s own words 

 Encouraging student to write letters that will improve their communication and teach 

them about writing and structuring letters 

A.  Read the passage given below carefully and answer the questions that follow: 

1. Overpowering prey is a challenge for creatures that do not have limbs. Some species like 

Russell’s viper inject poison. Some others opt for an alternative non-chemical method – rat 

snaked, for instance, catch and push their prey against the ground, while pythons use their 

muscle power to crush their prey to death. But snakes can’t be neatly divided into poisonous and 

non – poisonous categories. 

2. Even species listed as non – poisonous aren’t completely free of poison. The common Sand 

Boa, for instance, produces secretions particularly poisonous to birds. So, the species doesn’t 

take any chance - it crushes its prey and injects poison as an extra step. 

3. Do vipers need poison powerful enough to kill hundreds of rats with just one drop? After all, 

they eat only one or two at a time. 

4. While hunting animals try their worst to kill most efficiently, their prey use any trick to avoid 

becoming a meal, such as developing immunity to poison. For instance, California ground 

squirrels are resistant to northern Pacific rattlesnake poison. 

5. Competition with prey is not the only thing driving snakes to evolve more and more deadly 

poison. Snakes also struggle to avoid becoming prey themselves. 

6. Some snake killers have partial immunity to poison. Famously, mongooses are highly resistant 

to cobra poison and with their speed and agility, kill snakes fearlessly. It would be the death of 

cobras as a species if they didn’t evolve a more deadly poison to stop mongooses. 



2 Doon International School Srinagar 
 

 

7. Poison has another important role. It’s an extreme meat softener; specific enzymes break up 

the insides of the prey. Normally, a reptile depends on the sun’s warm ray to aid digestion. 

8. But I wonder if we cannot use venom in our favour. In remote parts of India, local hospitality 

often involves leather – tough meat. I chew and chew until my jaws ache. If I spit it out or refuse, 

our hosts would be offended; I swallow like python stuffing a deer, down its throat and hope I 

don’t choke. If only I had poison. 

1.  On the basis of your understanding of the above passage, answer the following questions 

in 30-40 words each:  

a. Russell viper and rat snake have different methods to attack prey. How? 

b. How does Sand Boa kill its prey? 

c. There is a constant tussle between the hunting animal and its prey? Why? 

d. What makes mongoose a snake predator? 

e. What difficulty does the writer face when he is entertained in the remote parts of India? 

 

2. On the basis of your reading of the above passage fill the following blanks.   

      

a) Overpowering ________________ is a challenge for creatures that do not have limbs. 

1. a killer  2. humans  3. a python 4. prey 

b) Poison ______________ meat. 

1. enhances taste of 2. haidens 3.softens  4. breaks down 

c) Californian squirrels are __________ rattlesnake poison 

      1. afraid of  2. helpless against 3.resistant to         4. indifferent to 

Note: Part 1 and 2 of the passage to be done on the classwork notebook. 

B. LETTER WRITING: Letter writing consists of certain norms. It is basically a step by step 

approach. These are the essentials of a letter: 

a) address of the sender 

b) address of the receiver  

c) date 

d) name of the person you are addressing the letter to 
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e) body of the letter with details 

f) closing 

g) the sender’s name 

 

 

 

 

 

SAMPLE 1: Write a letter to your brother advising him to take part in school debates. 

252, Canal Road 

Jammu 

March 25, 2020 

Dear Faizan 

I am glad to learn that you are doing very well in your studies. But your class teacher has 

informed me that you do not take part in debates of the school. It is very sad. 

You must take part in debates. You should prepare the topic of debate and learn to speak 

effectively. Debates increase your reasoning power. They teach you how to arrange your ideas 

and present your arguments to defeat your opponents. They increase your knowledge and enable 

you to speak smoothly. They remove your shyness to come to the stage. 

I hope you will act upon my advice and take part in debates in future. 

Yours affectionately  

Hamza 

 Write a letter to your brother advising him to read newspapers daily 

 Write a letter to your friend describing the Annual Sports Day Celebrations of your 

school 

 Write a letter to your father describing what you intend doing after finishing your studies 

(This part to be done on fair notebook) 

REMEMBER: Informal letters are written to people we are close to, like friends, relatives or family members. 

When you are writing a letter to your friend or relative: you begin the letter with – ‘Dear Father/ 

Mother/Uncle/(name of a friend)’ 

you end a letter with – ‘Yours affectionately’ or ‘yours loving friend/sister brother/daughter’ 
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SAMPLE 2: Write an application to the Principal of your school requesting him/her to 

grant leave. 

The Principal 

Doon International School 

HMT, Srinagar 

March 25, 2020 

Subject: Leave application 

Dear Sir 

I would like to mention that on 23 March and 24 March 2020 – I could not attend school since I 

was suffering from fever. 

I would remain grateful to you if you kindly grant me sick leave for those two days. 

Yours faithfully 

Mihir Shah 

Class VI 

Roll No. 03 

 Write a letter to your principal requesting him/her to issue a new School Diary 

 Write a letter to your principal requesting him/her to issue a new library card 

 Write a letter to the editor of a newspaper complaining of the  

frequent breakdown of electricity in your locality 

(This part to be done on fair notebook) 

 

Formal letters are written to Principal, teachers, Editors etc 

You begin these kind of letters with – ‘Dear Sir/Madam 

You end the letter with – ‘Yours faithfully’ 

You mention the ‘subject’ before the letter starts 
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DOON INTERNATIONAL SCHOOL, SRINAGAR 

                       SUBJECT: SST 

                     ASSIGNMENT:II 

                                  GRADE: VI 

             CHAPTER NO:5 -THE AGE OF VEDAS. 

Instructions: 

• The objective of this assignment is to make students acquainted with 

the Vedas because most of the information of the Early Vedic Age 

comes from the Rig Veda.  

                   Crux of the chapter is given below: 
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Important points to remember about this chapter: 

Vedic Age: The period in which the Vedas were composed. 

Veda: Wisdom or knowledge. 

Megalith: Big stones. 

Grihastha: Life of a hoseholder. 

Coronation: A ceremony where a person is made the king or queen. 

The Vedic Age: (a) The Early Vedic Age (1500 BCE to 1000 BCE). (b) The Later Vedic Age 

(1000 BCE to 600 BCE). 

The Vedas. Composed in archaic, or Vedic, Sanskrit, generally dated between 1500 and 800 

BCE, and transmitted orally, the Vedas comprise four major texts—the Rig-, the Sama-, 

the Yajur-, and the Atharvaveda. Of these, the Rigveda is believed to be the earliest. The 

texts consist of hymns, charms, spells, and ritual observations current among the Indo-

European-speaking people known as Aryans (from Sanskrit arya, “noble”), who 

presumably entered India from the Iranian regions. 

Time to learn- Page no. 31. 

A. Tick the correct answers. 

1. Knowledge.         

2. 1500-600 BCE 

3. Aryans. 

4. Rajan. 

5. Soma. 

6. Cattle-rearing. 

7. Slave. 

8. Megalith. 

B. Give one word for the following- Page no. 32. 

1. Mandalas. 

2. Painted Grey-ware. 

3. Cow. 

4. Inamgaon. 

C. Solve the following crossword- Page no. 32. 

     Across                                             Down 

1. ARYANS.                              2.  RIG VEDA 

3.HORSE.    

4. MEGALITHS. 

https://www.britannica.com/topic/Veda
https://www.merriam-webster.com/dictionary/archaic
https://www.merriam-webster.com/dictionary/comprise
https://www.britannica.com/topic/Rigveda
https://www.britannica.com/topic/Aryan
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      D. Give short answers for the following questions. 

                  1. What are the Vedas? What do they contain? 

                  Ans. The Vedas mean knowledge. 

                              The Vedas contain hymns in praise of various goddesses and gods. These             

hymns were recited and passed from one generation to the next. 

2. What is the difference between sabha and samiti? 

Ans. The sabha was an assembly of important people and elders. On the other hand, 

samiti was a general assembly of members of every family of the tribe or jana. 

3. Describe the pottery and stone tools found at Inamgaon. 

Ans. The pottery found at Inamgaon is red in colour. Some have black designs on 

them. The stone tools could have been used to chop trees, pound meat and skin 

animals. 

4. What do objects found in the megalithic graves indicate? 

Ans. The objects in the megalithic graves indicate the position that the buried person 

held in his/her tribe. 

E. Give long answers for the following questions. 

1. What are the archaeological sources for the Vedic Age? 

Ans. The archaeological sources for the Vedic Age include two types of pottery- the 

Painted Grey Ware and the Black-and-Red Ware. These potteries tell us about the life of 

the people during the Vedic age. 

2. What were the different occupations of the people? 

Ans. Agriculture and cattle-rearing were the main occupations of the Vedic people. 

Chariot-making, pottery-making, weaving, jewellery-making, metal-working, carpentry, 

tanning, and fishing were some other occupations followed by the people in the Vedic 

Age. 

3. Write short notes on- the Rig Veda, Megaliths. 

Ans. Rig Veda- The Rig Veda is the oldest of the four Vedas. It was written about 3500 

years ago. It is divided into 10 books called mandalas. The Rig Veda contains 1028 

hymns in praise of gods such as Indra, Agni and Varun. 

 Megaliths- Megaliths means ‘big stones’. They were huge stone boulders arranged in a 

circular pattern. They were used, perhaps, to mark graves or burial sites. Megaliths have 

been found in the Deccan, the South, and in the north-east and north-west India. 
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             CHAPTER NO:6 –EARLY KINGDOMS. 

Instructions: 

• The objective of this assignment is to make students acquainted with 

the tribes of earlier period, their socio-political system,trade,etc.  

                   Crux of the chapter is given below: 

             Janapadas and Mahajanapadas 
The Janapadas were the major kingdoms of Vedic India. By the 6th century B.C. there 

were approximately 22 different Janapadas. With the development of iron in parts of UP 

and Bihar, the Janapadas became more powerful and turned into Mahajanapadas. There 

were sixteen such Mahajanapadas during 600 B.C. to 325 B.C. in Indian Sub-continent. 

The Janapadas were the major kingdoms of Vedic India. By the 6th century B.C. there were 

approximately 22 different Janapadas. 

The key points related to the Janapadas and the Mahajanapadas are as following: 

1. The Janapadas were the major kingdoms of Vedic India. 

2. Aryans were the most influential tribes and were called as ‘janas’. This gave rise to the term 

Janapada where Jana means ‘people’ and Pada means ‘foot’. 

3. By the 6th century B.C. there were approximately 22 different Janapadas. 

4. With the development of iron in parts of UP and Bihar, the Janapadas became more powerful 

and turned into Mahajanapads. 

5. In the sixth century BCE, there was a rise in the development of the Mahajanapada or great 

country. There were sixteen such Mahajanapadas during 600 B.C. to 325 B.C. in Indian Sub-

continent. There were two types of states: Monarchical and Republican. 

Malla, Vajji, Kamboja and Kuru were Republican states while Magadha, Kosala, Vatsa, Aanti, 

Anga, Kashi, Gandhara, Shursena, Chedi and Matsya were monarchical in nature. 

There were 16 Mahajanpadas during 600 B.C. to 325 B.C. which are mentioned in early 

Buddhist (Anguttara Nikaya, Mahavastu) and Jain literature (Bhagvati Sutta), those were as 

follows- 

Name of the 

Mahajanapada 
Capital Location 

Anga Champa 
Included the modern districts of 

Monghyr and Bhagalpur in Bihar. 

Magadha Earlier Rajgriha, later Patliputra 
Covered the modern districts of Patna, 

Gaya, and parts of Shahabad. 

Malla Capitals at Kusinara and Pawa 

Covered the modern districts of Deoria, 

Basti, Gorakhpur and Siddarthnagar in 

eastern UP. 
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Vajji Vaishali 
Situated north of the river Ganga in 

Bihar. 

Kosala Sravasti 

Covered modern day districts of 

Faziabad, Gonda, Bahraich of eastern 

Uttar Pradesh. 

Kashi Varanasi 
Located in the region around Varanasi 

(modern Banaras). 

Chedi Shuktimati 
Covered present day Bundelkhand 

region. 

Kuru Indraprastha Covered modern Haryana and Delhi. 

Vatsa Kaushambi 
Covered modern districts Allahabad, 

Mirzapur. 

Panchala 

Ahichhatra(Uttara Panchala) 

and Kampilya( Dakshina 

Panchala) 

Covered the area of present western UP 

up to the east of river Yamuna up to 

Kosala janapada. 

Matsya Viratanagara 
Covered the areas of Alwar, Bhartpur 

and Jaipur in Rajasthan. 

Sursena Mathura Covered the area around Mathura. 

Avanti Ujjaini and Mahishmati 
 Covered the western India (modern 

Malawa). 

Ashmaka Potana 

Situated in the southern part of the India 

between the rivers Narmada and 

Godavari. 

Kamboja 
Capital at Rajapura in modern-

day Kashmir 

Covered the area of Hindukush (modern 

Hazara districts of Pakistan) 

Gandhara Taxila 
Covered the western part of Pakistan and 

eastern Afghanistan. 

Among them Magadha, Vatsa, Avanti and Kosala were the most prominent ones. Out of these 

four, Magadha emerged as the most powerful kingdom. The causes of Magadha’s success were 

as following: 

1. Availability of rich iron deposits which were used in making weapons. 

2. Its location at the rich and fertile Gangetic plain. 

3. Use of elephants in military warfare against its neighbors. 
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Time to learn- Page no. 38. 

A. Tick the correct answers. 

1. Iron. 

2. Janapadas. 

3. 16. 

4. Vatsa. 

5. One-sixth. 

6. Bimbisara. 

7. Birth. 

8. Vaishali. 

B. Write True or False. 

1. False. 

2. False. 

3. False. 

4. False. 
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C. Give short answers for the following questions. 

1. What are the sources that tell us about the early kingdoms? 

Ans. The sources that tell us about the early kingdoms are the Brahmanas, the Upanishads 

and the Jataka Tales. 

2. Write a short note on monarchical mahajanapadas. 

     Ans.  Monarchical mahajanapadas were ruled by kings. The kings were powerful and kept       

large armies. Kingship was hereditary. Magadha, Vatsa, Avanti and Kosala were some 

monarchical mahajanapadas. 

3. Besides agriculture, what were the other sources of revenue? 

Ans. Besides agriculture, the other sources of revenue were taxes that the potters, carpenters 

and weavers paid, either in cash or kind. Taxes were also levied on buying and selling goods. 

4. How did towns emerge? Name some important towns of this period. 

Ans. Towns emerged when villages grew in size. Places which were centres of trade and 

craft or where artisans came to work also emerged as towns. 

        Ujjayini, Vaishali, Ayodhya, Kaushambi, Tamralipti and Champa were some important 

towns of this period. 

D. Give long answers for the following questions. 

1. How did the small tribes of earlier period give way to large kingdoms? 

Ans. As iron began to be used on a large scale, the thick forests of the Ganga plains were 

cleared for bigger settlements. The small tribes of the earlier period, thus, gave way to large 

kingdoms called janapadas. 

2. What changes in agriculture helped farmers to produce more? 

Ans. Two changes in agriculture helped farmers to produce more. These were as follows: 

• A greater use of the iron plough instead of the wooden plough. 

• Growing paddy saplings separately and then planting them in the fields. 

3. Which factors led to an increase in trade during this period? 

Ans. Trade increased in this period as money began to be used. Introduction of copper and 

silver coins helped in the expansion of trade. Bridges and roads also facilitated trade. Besides 

land routes, trade was also carried out through sea routes. 

4. Name the four varnas. What tasks did each perform? 

Ans. Brahmins, Kshaitriyas, Vaishyas and Shudras were the four varnas. 
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             The Brahmins taught the Vedas and performed religious rituals and sacrifices. The 

Kshatriyas fought wars. The Vaishyas were traders and agriculturists. The Shudras served 

people of the three varnas.  

                              ___________________________________________ 
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DOON INTERNATIONAL SCHOOL SRINAGAR
SUBJECT: SCIENCE

Solved Assignment:II
Grade:VI

CHAPTER : MEASUREMENT AND MOTION

The objective of this assignment is:

 To make students acquainted with the concept of measurements and the standard units of

measurement.

 To help our students to understand the concept of motion and its types.

Key concepts:

Physical Quantity:

A physical quantity is a property of a material or system that can be quantified by measurement. A

physical quantity can be expressed as the combination of a magnitude and a unit. For example, the physical

quantity mass can be quantified as n kg where n is magnitude and kg is the unit (e.g. 2 kg).

Measurement:

When there is a comparison of an unknown quantity with some known quantity, it is called a

measurement. The result of measurement has two parts:

 The first part of the measurement consists of a number (1, 2,3,4,5 …… etc.) which tells us the

‘magnitude of measurement.’

 Second part tells us the ‘name of the unit of measurement’. Every measurement consists of a

number and a unit.

Thus every measurement consists of a number and a unit. For example: if the length of table is 2 meters,

then 2 is the number and meter is the unit. The number ‘2’ tells us the magnitude of the length of the table

and ‘meter’ tells us the unit in which the length has been measured. A measurement is not complete unless

both, the number and the unit are mentioned.

 Non -standard measures: We can measure the length of an object by using ‘hand-span’, ‘forearm

length’ or ‘foot step’ as the units of measuring length. But hand span, forearm length and foot step

cannot be used as standard units’ measurements because their length is not the same for all the

persons.
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The length of hand-span, forearm-length and foot step of different persons is different. It varies

from person to person. So, hand span, forearm length and foot step are not standard units of measuring

length.

 Standard unit of measurement:

Measures that are same all over the world are known as standard measures. In October 1960, the 12th

general conference on weight and measure adopted the international system of units. “The Systeme

International Unit” is the set of units to maintain uniformity all over the world.

1. Meter is a SI Unit of measuring length, the symbol of the meter is m.

2. The SI Unit of measuring mass is kilogram. Its symbol is kg.

3. The SI unit of measuring time is second. It is indicated as s.

Multiples and submultiples of unit:

 The multiples of Metre: The SI unit of length is metre. When a larger

distance is to be covered, we cannot use metre. So to cover a larger distance we

use km (kilometre), hm (hectometre), and dac (decametre). These are called the

multiples of metre.

 The submultiples of Metre: When the distance is smaller, we use Dm

(decimeter), cm (centimetre) and mm (millimetre). These are called the

submultiples of Metre

Measurement of length:

The length is the distance between two points. Meter is used as a standard unit for measuring the length

of an object. We measure the length of an object by using a meter scale. A meter scale is graduated (or

marked) in 100 centimeters and every centimeter is further divided into 10 divisions called millimeters.

1 meter = 100 centimeters 1 centimeter = 10 millimeter
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The use of proper Units of Length:

“Meter” is the standard unit of length but sometimes other units of length like centimeters, millimeters

and kilometers are also used for the sake of

convenience. The type of unit used depends on

the magnitude of the length to be measured.

1) Meter can be used as unit to measure the

length of a table or a room or height of a tree or

building.

2) The length of small objects is measured in

centimeters, e.g. pencil or a notebook.

3) The very small lengths are expressed in still

smaller units called ‘millimeters’ e.g. the

thickness of a coin or a thin wire. One mm (millimeter) is the smallest length which can be

measured accurately by using a meter scale.

The distances between two cities are very large. The large distances (or lengths) are measured in a

big unit of length called “kilometer”

1 kilometer = 1000 meters 1 km = 1000 m

 Length Measuring Devices

The various types of devices which are commonly used for

measuring length are:

 Meter scale.

 Measuring tape.

A meter scale is made of metal and cannot be bend. The rulers are

made of plastic, wood or metal and also cannot bend. The measuring tape is however made of flexible

material which can bend easily around the object which has to be measured.

1. If the object is straight: we can use either a meter scale or a measuring tape to measure its length.

For example: the length of a table can be measured by using a meter scale or a measuring tape. A

cloth seller uses a meter rod for measuring cloth.

2. If the object is round: we use a measuring tape to measure for making measurement of length. For

example: The girth of a tree can be measured only by using a measuring tape because measuring

tape can be bent around the tree. The tailor also measures our chest and waist by using a measuring

tape.
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We cannot use an elastic measuring tape to measure lengths. This is because an elastic measuring tape

can stretch easily while taking measurements and hence give a wrong value (greater value) of length of an

object than its actual length. So, though a measuring tape is flexible but it is made of non-stretchable

material. A ruler is a short scale marked in centimeters and millimeters. These rulers are usually made of

plastic, Scales made of metal or plastic are also available in the market.

 Precautions to be taken while using a scale:

The precautions to be taken while using a meter scale to measure lengths are as follows:

1) The scale should be placed to the side of the object being measured. It should also be in touch with

the object being measured.

2) While reading the scale, eye must be placed vertically above the scale mark being read. If the eye is

not vertically above the scale mark being read, then the reading becomes wrong.

3) If the scale has a damaged zero mark or broken left end, measure the length of an object starting

from 1 cm mark of scale and then subtract 1 cm from the reading taken at the right end to get the

actual length of objects.

To measure the Length of a curved line:

A wavy line is known as curved line. We cannot measure the length of a curved line by using a scale

directly.

The length of a curved line can be measured by using a thread and a scale.

1) We take a piece of thread and put a knot near its one end.

This knot will act as a starting point for measuring the length of

the curved line.

2) Place the knot of the thread at a point A on the left end of

the curved line with the help of thumb and forefinger.

3) Hold the thread a little distance away from the knot and

keep it along the curved line with the help of right thumb and

forefinger.

In this way, run the thread all along the curved line in little steps at a time, keeping the thread taut, till the

other end B of the curved line is reached. Make an ink mark on the thread where it touches the other end B

of the curved line. Now, straighten the thread and measure its length between the knot and the ink mark by

keeping it along a scale. This will give us the length of the curved line.

 Stationary objects:
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Objects which remain fixed at a place e.g. tree, house, school, factory, telephone pole, electric pole are

called stationary objects.

 Motion is defined as the change in position of an object with respected to a stationary object. For

example: When the position of a car changes with time, we say that the car is moving or that car is

in motion.

 Story of Transport:

 Early man used to walk to travel.

 With the passage of time, man began using animals to

transport people and luggage.

 Boats were probably built after seeing the shape of aquatic

animals. Initial boats were made by making hollow in wooden logs. The

shape was later refined into streamlined shape.

 Discovery of wheel dramatically changed the modes of

transport. Animal driven carts could become a possibility after the discovery of wheel.

 Steam engines brought the next big revolution in the modes of transport. Steam engines

altogether replaced the animal driven carts. Railways network spread because of steam engines.

 Internal combustion engines made it possible to replace steam engines. Moreover, internal

combustion engines also made it possible to make vehicles for personal transport.

 Jet engines helped in making the aircrafts faster.

 Types of motion:

 Rectilinear Motion: When an object moves along a

straight line, it is said to be undergoing rectilinear motion.

For Example, A train moving along a railway track.

 Circular Motion: Have you seen the hands of a

clock? The motion exhibited by the hands of a clock is called

Circular Motion.

 Periodic Motion: When an object repeats its motion

after a fixed interval of time it is said to be undergoing

periodic motion. For Example, Pendulum.

 Rotational Motion: This motion can be easily understood by imagining Earth’s rotation. When the

Earth spins on its own axis it is said to be undergoing rotational motion.
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SOLVED QUESTION- ANSWERS (to be done on fair note-book)

C. Short-answer questions:

1. Standard units are used in measurement because they remain same everywhere and does not change. This

makes measurement easier.

2. CGS system (centimetre, gram, second). SI system (metre, kilogram, second)

3. To make accurate measurements we must use appropriate measuring instruments and also know how to

use these instruments properly.

4. An object is said to be in motion if its position changes with time, in relation to a stationary object in its

surroundings.

5. The invention of the wheel and the invention of the steam engine brought about revolutions in transport.

6. Rotational and translatory motion.

D. Long- question answers

1. Because calculations with very large or very small numbers become very difficult and therefore,

impractical.

2. (i) Keep the ruler exactly along the length to be measured.

(ii) Avoid using worn out portions of the instrument.

(iii) Keep the eye vertically above the point where the measurement is to be taken.

3. Two methods we can use to measure the length of a curved line are: by using a thread, by using a

divider.
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4. a. Accurate measurement is necessary while conducting an experiment in the laboratory.

b. Only estimation is required while cooking in the kitchen. Because in an experiment, a slight

mistake can lead to wrong result but in cooking a curry, a minor error in measurement will make no

difference to its taste.

5. Translatory motion is of two kinds:

(i) Linear or rectilinear motion – when the object moves in a straight line, for example, a car running

on a straight road, a bullet fired from a gun.

(ii) Circular or curvilinear motion – when the object moves along a curved path, for example, a

cyclist going along a circular track.

6. If the same motion occurs again and again, it is said to be repetitive motion. Repetitive motion that

repeats itself at regular intervals of time is called periodic motion. For example, pendulum of a

clock and revolution of the earth around the sun.

Additional questions:

1. What do you understand by standard unit of measurement?

2. Why is the hand span not considered as a reliable unit for measuring the length?

3. What is the difference between motion of ceiling fan and motion of a pendulum?

4. Why can’t we use elastic tape to measure distances?

5. The distance between ram’s house and Ravi’s house is 3000 m. Express it in km.

Skill based questions:
6. Four children A, B, C and D measure the length of a table which was about 1 m. Each of them used

different ways to measure it.

(i) A measured it using a 2 m long measuring tape.

(ii) B measured it with a 10 cm scale from her geometry box.

(iii) C measured it using her hand span.

(iv) D measured it with a 5 metre long thread.
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Which one of them would get the most accurate length? Give reason for your answer.

7. Sam is travelling in a train. He observe that the trees near the track appears to be moving whereas

co-passengers appear to be stationary. He is curious to know the reason. Help him out.

8. Three students measured the length of a corridor and reported their measurements. The values of
their measurements were different. What could be the reason for difference in their measurements?
(Mention any three).
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DOON INTERNATIONAL SCHOOL SRINAGAR
SUBJECT: SCIENCE

Solved Assignment:II
Grade:VI

CHAPTER : SEPARATION OF SUBSTANCES

 The objective of this assignment is to:

 Make our students acquainted with the concept of mixture, its types and properties.

 Help our students to understand and appreciate the need and methods of separation.

New terms:

• Churning: The process of shaking milk or cream in order to allow lighter particles to come to the

surface in order to make butter is called churning.

• Pure Substance: This can be defined as a substance composed of only a single type of particle.

• Impure Substance: A substance composed of more than one type of particles.

• Sublimation: When a solid directly gets converted into vapour, this process is known as

sublimation.

• Solute: A very small element in a solution that is dissolved in a solution.

Mixtures:

In Chemistry when two or more substances mix with each other it results in the formation of a

Mixture. The product formed due to the combination of substances does not lose its individuality

nor are they combined chemically. In other words Mixtures are made up of two or more substances

that are not chemically combined with each other.

General Properties of Mixtures

The properties of mixtures are listed below:

 The components of a mixture keep their original properties.

 The separation of components can be easily done.

 The proportion of the components is variable.

Types of Mixtures:

There are two main categories of mixtures:

 Homogeneous mixtures: In a homogenous mixture all the substances are evenly distributed
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throughout the mixture (salt water, air, blood).

 Heterogeneous mixtures: In a heterogeneous mixture the substances are not evenly distributed

(chocolate chip cookies, pizza, rocks)

Importance of separation:

On a day-to-day basis, we are facing with various instances when we are required to separate substances

from one another. Whether it is picking out chilies from our paranthas or, separating tea leaves from tea

while serving it, the need for separation of substances is something we encounter on a daily basis. It is

usually because of one or all three of the following reasons:
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SEPARATING SOLIDS FROM OTHER SOLIDS:

1. Handpicking:

The simple process of separating slightly bigger sized harmful substances or

other useful substances or impurities like small pieces of stones, husk and dirt

from grains of wheat, pulses and rice is called handpicking. In situations when

the quantity of such impurities is not very large, handpicking turns out to be a

time-saving and convenient procedure of separating substances.

2. Threshing:

After the crop is harvested, stalks are left to dry under the sun. A single stalk

has some 100 pieces of grain seeds joined to it. It is manually impossible to pluck

each grain seed which is very small in size from the stalk and hence handpicking as

a method of separation does not work here. That is why we use a method called

threshing to separate these grain seeds. Threshing can be defined as the process of separating the edible

part i.e. grain seeds from the stalk by either with the help of machines, bullocks or sometimes by beating

them.

3. winnowing:

Once when threshing is done, husk or chaff is still attached to the grain seed and

since the size of the two is quite similar, handpicking does not work and neither

does threshing. Hence, a method called winnowing can be used. Winnowing can be

defined as the method of separating lighter husk particles and heavier grain seed

components by blowing a current of air through them. The lighter husk particles

are carried away by the wind and the grain seeds get separated. This husk can be further used as fodder for

the cattle.

Methods of Separation

Separating solids from
other solids

Hand-
picking

Threshi
ng

Winnow
ing Sieving Magnetic-

separation

Separating liquids

Sedimenta
tion

Decanta
tion

Filtratio
n

condens
ation

Distillati
on

separating
funnel
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4. Sieving:

Sieving is a simple, convenient and time-saving process by which particles of varying

sizes can be separated from each other with the help of a sieve. A sieve is a simple

device with small pores in it which allow finer materials like flour to pass through

leaving behind any impurities it might contain.

5. Magnetic Separation:

This is another method of separation which allows metals (and other articles which are

attracted to a magnet) to be separated from a mixture with the help of a magnetic or by

applying a magnetic force to it. For example, a mixture of salt and iron filings

SEPARATING LIQUIDS

1. Sedimentation:

Sedimentation can be defined as the process of allowing particles in suspension in water to settle

out of the suspension under the effect of gravity. When the dust and dirt particles settles, the clear water

which forms the upper layer is moved to a different container and the dirt and dust is done away with. This

technique can also be used to separate two liquids which do not mix with each other (also called

immiscible liquids) and is called decantation.

2. Decantation:

Decantation can be defined as a technique by which immiscible liquids or a liquid and a solid

substance can be separated. For example, take the case of oil and water. These are two examples of

immiscible liquids. Once we pour oil in water, oil forms the upper layer of water and can be easily

separated by gently pouring the mixture in another container till all the oil has been removed. Sometimes

smaller dirt particles get carried along with the water in the process of decantation which needs to be

further removed. This can be achieved through the process of filtration.

3. Filtration:

Filtration is the process by which suspended solid matter is separated from

solution by making the solution pass through a medium (often a filter paper).

This medium is such that only liquids are able to pass through it because of the

presence of very tiny pores in it. The filter paper is molded to form a cone and

this cone-like structure is then affixed to a funnel through which the dirty

solution is allowed to pass. Sometimes, filtration can also be applied to

separate pulp and seeds from the juice. It can also be used to separate cottage cheese or paneer from milk.
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4. Evaporation:

Evaporation is the process of converting liquid into gas or vapour by increasing the

temperature or pressure of the liquid. This process is often used to separate salt from

salt water or salty sea water. Sea water has a number of salts present in it. Shallow

pits called evaporation ponds are constructed and salt water is allowed to stand in

these. After some time, the water gets evaporated, leaving behind the salts. Common

salt is separated from this mixture upon further purification.

5. Condensation:

Condensation is defined as the simple process of converting gas or vapour to its

liquid form by decreasing the temperature or pressure exerted on it. The mirror in

the bathroom during a shower becomes foggy because warmer water vapour in

the air hits the cooler surface of the mirror. Likewise when you get in your car in

the morning and are breathing warmer air, the warm air comes into contact with

the cooler windshield and forms a foggy window.

6. Distillation Process:

The process of distillation begins with heating a liquid to boiling point. The

liquid evaporates, forming a vapour. The vapour is then cooled, usually by

passing it through pipes or tubes at a lower temperature. The cooled vapour

then condenses, forming a distillate. The distillate is a purified form of the

original liquid. When the liquid evaporates, many impurities are left behind, so

they are not present in the distillate.

7. By the method of separating funnel:

A separating funnel is used to separate immiscible liquids. Liquids that do not mix

with each other are said to be immiscible. Two immiscible liquids, such as oil and

water, can be separated by using a separating funnel. The mixture is placed in a

separating funnel and allowed to stand. The oil and water form two separate

layers, with the less dense liquid being on top. The stopper is removed and the tap opened. The bottom

layer is run off and collected in a container placed under the tap. The top layer remains and can be

collected in a separate container.

SOLVED QUESTION- ANSWERS: (to be done on fair note-book)

C. Short-answer questions:

1. Pure water boils at 1000 C. However, if there are dissolved substances in the water, its boiling point goes

up. Thus, by measuring the boiling point we will know whether the water is pure or not.
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2. To separate a mixture into its constituents we have to use some property that one constituent has while

the others do not have.

3. The size of the holes of the sieve should be bigger than the size of sand particles and smaller than the

size of rice seeds.

4. The filter paper has fine holes which allow a liquid to flow through, but not the particles of an insoluble

solid. This helps it to separate the insoluble solid from the liquid.

5. The temperature of a saturated solution is specified because the solubility of most substances increases

with temperature.

6. Hand picking can be used to separate the constituents of a mixture only when the particles of the

undesirable substance have different colour, shape and size and are present in small quantities.

7. Objects at a distance are seen more clearly after rain as loading of dust particles in air takes place when

it rains. The dust particles become heavier and settle on the ground.

8. To load means to make it heavier. In loading, the fine suspended particles are made heavier to make

them settle down.

D. Long- question answers:

1. The constituents of a homogeneous mixture cannot be seen separately, for example, sugar in water,

whereas the constituents of a heterogeneous mixture can be seen separately, for example, chalk powder in

water.

2. The three properties of mixtures are

(i) The constituents of a mixture may be in any ratio.

(ii) The constituents retain their individual properties.

(iii) The constituents can be separated by simple methods.

3. (i) To remove undesirable constituents, for example, harmful substances present in river water.

(ii) To obtain useful constituents, for example, butter can be obtained from milk or curd by churning it.
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5.

.

6. First of all we remove pebbles by hand picking. Grass can be separated by filtration and sand can be

separated by sedimentation and decantation. Pour oil and water in a separating funnel and let it stand for

some time. You can clearly see two layers water at the bottom and oil on top. Carefully turn the stopper of

the funnel and allow the water to flow out into a beaker placed below the funnel. Stop the flow as soon as

the layer of oil reaches the stopper.

7.

8. In the process of digestion, food is reduced to simple substances that are soluble in water. They can then be

dissolved in water and absorbed by the body. Several waste materials produced in the body are dissolved in

water and excreted. A number of chemical reactions occur inside our body. They all occur in the presence
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of water. Plants can absorb nutrients from the soil only if they are soluble in water. Minerals from the roots

and food from the leaves are transported to different parts of the plant in the form of solutions in water.

Additional questions:

1. Elaborate the terms:

a. Distillation c. Condensation

b. Winnowing d. Decantation

2. Write the name of method for separating-

a) Oil from mixture of water and oil.

b) Wheat from mixture of wheat and rice.

3. What happens when steam comes in contact with the metal plate cooled with ice

4. How is sieving use to separate particles of a mixture? Give example.

5. How does the farmer separate grains seeds from bundles of stalk?

Skill based questions:

6. Your family goes to Dandi beach in Gujarat. Explain your younger brother how salt workers make salt

from sea water.

7. While playing with your friends, one of your friend throws hand full of sand in a bucket of water. Can

you still suggest the ways to separate water from sand?
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              DOON INTERNATIONAl SCHOOL,SRINAGAR 

SUBJECT – Computer  

Assignment:II 

   Grade:VI                              

Chapter:- More on windows 7 

 
 

• The objective of this assignment  is to make the students get acquainted with new features of 

Windows 7 and various other accessories in it. 

  
Introduction 

Windows has many utility programs for day to day applications and entertainment. These 

additional programs are known as accessories e.g Calculator ,Notepad ,Windows media 

player, sound recorder system tools etc .Accessories are additional programs . 

Windows media player  

Windows  media player is used to play and organize digital media files (audio and video) on 

a computer and internet .We can listen to radio stations from all over the world ,play and 

copy CD/DVD ,create our own CD/DVD and copy music and video to portable devices. 

Ripping  

Ripping means copying data from a CD to a computer. 

Disk clean up  

Disk clean up removes the temporary  internal files ,downloaded program files  and other 

items that are not being used for a long time . 

Question /answers  

Qno.1:-What is windows media player? 

Ans:-Windows media player is an accessories of windows 7   which is used to play and 

organize digital media files  on a computer and internet. We can also  listen to radio stations  

from all over the world, play and copy CD/DVD .we can also create our own CD/DVD  and 

copy music and video to portable devices. 

Qno.2:-What do you understand by burning a CD? 

Ans :-Burning a CD means copying data from computer to CD.Burned data  can  not be 

edited . 
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Qno.3:-What is Windows mobile ? 

Ans :-Windows mobile software powers advanced ,easy to use devices that allow the users  

to send and receive e-mail, browse the internet and  hundred of application available to 

extend the platform. Windows  mobile works differently depending upon place, time and 

nature of work . 

Qno.4:-How will you display two application  windows side by side? 

Ans:-To display two windows side by side 

Step 1:-Open Ms word and Ms Excel programs one by one .The  excel  window is active at 

present.   

Step 2:-Now, right click anywhere on the blank portion of the taskbar. 

Step 3:-Click on show windows side by side option from the short cut menu. Both the 

application  

Windows will be displayed side by side. 

Qno.5:-What is meant by Disk cleanup? 

Ans :-Disk cleanup helps to remove the number of unnecessary files from hard disk to free 

up disk space and to help computer run faster. It removes the temporary  internal files 

,downloaded program files  and other items that are not being used for a long time . 

Answer the following questions 

Qno.1:-What is Windows on a computer? 

Qno.2:-Define MPEG. 

Qno.3:-Write short note on  

1.Touch screen    2.Windows taskbar 

Qno.4:-Mention the various features of Windows 7. 

Practical work:- 

• Copy an audio CD to you computer. 

• Display two windows side by side. 

Note:-Do all the textual and additional questions on fair notebook. 
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DOON INTERNATIONAL SCHOOL, SRINAGAR 
SUBJECT: MATH 

Assignment:II 

Grade:VI 

Chapter: Basic Geometrical Ideas  

 

Instructions: 

➢ The objective of this assignment is to make the students acquainted with; 

• Basic elements of geometry. 

• Students will come to know the measurements of line segments, 

angles. 

• They will come to know the types of angles. 

• The definition of unit of measure of an angle. 

 

 

Point: A fine dot which is used to locate the position of an object is called a point. It has no 

            part, no length and no width or it is a circle with zero radius. 

Collinear Points: Three or more points are said to be collinear if they lie on the same straight 

                               line. 

Non collinear points: Three or more points are said to be non collinear if they do not lie on 

                                       the same straight line. For example; three vertices of a triangle 

                                       represents non collinear points.     

Line: - The continuous pattern of points very close to each other such that they make a 

            straight path is called line. It has two arrow heads which represents that it can 

            be expanded on both sides.  
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Parallel lines: - Two or more lines are said to be parallel lines if they lie on the same 

                           plane and never meet if expanded on both sides. For example two 

                           lines drawn below are parallel lines. 

 

 

 

   

Perpendicular lines: - Two or more lines are said to be perpendicular lines if they are 

                                       making 90 degrees angle with each other. For example the two 

                                       lines drawn below are perpendicular to each other. 

 

 

 

 

 

 

Line segment: - The part of the line with two end points is called line segment. It has 

                             two end points which represents its length cannot be increased; means 

                             it has finite length.  

 

Plane: A flat surface that extends indefinitely in all possible directions is known as a plane. It 

is also known as a 2-dimensional surface. 

Measuring line segment: The length of a line segment can be measured because it has end 

points. We know that the line segment AB can be written as AB . The length or the measure 

of line segment AB is simply written as AB. The length of a line segment is a distance which 

can be measured in m, cm, mm, etc. A ruler (scale) is used to measure a line segment.  

 

 



3 Doon International School 

 

 

 

 

 

 

The length of above line is now 5.5cm, it is done when one end point is coincided with 0 and 

looking for the position of other end point of the line segment, which is on 5.5. Hence its 

length is 5.5cm.  

Comparison of line segments: Since the lengths of line segments are finite, therefore we can 

compare their lengths by; 

i) Comparison by observation: In this method, we simply observe the line segments 

and decide the bigger or smaller one. 

ii) Comparison by divider: In this method, we simply use a divider to compare their 

lengths. We stretch the arms of divider up to the length of one line segment and 

place it on another line segment for comparison. 

iii) Comparison by tracing: In this method, we simply trace one line segment over 

the other line segment, in result either it covers the line segment, or becomes 

shorter or exceeds due to which one can decide which line segment is shorter and 

which one is longer. 

  

Angle: Two lines or line segments or rays with a common starting point form an angle. The 

common starting point is called vertex and the two rays or lines are called arms of the angle.  
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Suppose the rays OP and OQ with same initial point are pointing towards right. Suppose ray 

OQ rotates in anticlockwise direction, it forms a positive angle and is named as ∟POQ. The 

alphabet which represents the vertex is always written in the middle. So we cannot name 

the above angle as ∟PQO or ∟QPO. 

 

Magnitude of an angle: The amount of rotation from OA to OB in the above figure gives the 

magnitude of the angle. The basic unit of measure of angle is degree. If we divide the 

complete one into 360 equal parts, each part is called one degree. It is denoted by (o). For 

example 45 degrees is written as 45o. 

Adjacent angles: Two angles are said to form adjacent angles if they have common vertex 

and common arm. The two other rays lie on the either side of the common arm. 
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Types of angles: 

On the basis of measure of angles, they are divided into following types: 

i) Acute angle: An angle whose measure is less than 90o is called acute angle. For 

example, the angle formed by stretching the first and middle finger of our left 

hand is an acute angle. 

ii) Obtuse angle: An angle whose measure is more than 90o is called obtuse angle. 

For example, the angle formed by the hands of clock at the time of 2:50. 

iii) Right angle: An angle whose measure is 90o is called right angle. For example, the 

angle formed by the hands of clock at the time of 3:00. 

iv) Straight angle: An angle whose measure is 180o is called straight angle. For 

example, the angle formed by the hands of clock at the time of 2:45. Or angle 

formed by the two rays with common initial point and are opposite in direction. 

v) Complete angle: An angle whose measure is 360o is called complete angle. For 

example, the angle formed by the ray when it turns a complete revolution. 

 

 

 

 

 

 

vi) Zero angle: An angle whose measure is 0o is called zero angle. The angle formed 

by the two rays pointing towards the same direction without any revolution. 

vii) Reflex angle: An angle whose measure is greater than 180o and less than 360o is 

called reflex angle.           
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Q1. Question no. 3 of exercise 10.2. page no. 145, there are some line segments drawn. We 

        have to write the measurements of line segments in ascending order. 

Sol. By using ruler and measuring them as we learnt above; CD=2.8cm, AB=2.4cm, GH=1.4cm 

       and EF=1.3cm. 

Now ascending order of their measurements are: EF, GH, AB and CD 

Q2. A kriti found that some of the initial marks at the beginning of her scale are faded. So, 

        she decided to use the 2 cm mark for measuring the lengths. What is the length of PQ if 

        the centimetre mark against the point Q is 11.5? 

Sol.  So the initial mark is = 2cm 

  Final mark is = 11.5 cm 

 Therefore length of PQ = 11.5 cm – 2 cm 

      = 9.5 cm 

Q3. Name the following angles: 

 72o, 180o, 205o, 91o, 100o 

Sol. 72o acute angle 

 180o straight angle 

 205o reflex angle 

 91o obtuse angle 

 100o obtuse angle 

Q4.  How many degrees are there in: 

 Two right angles? One and a half right angle? 
5

9
 right angles? 

Sol. (a) Two right angles = 2 × 90 = 180o 
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(b) One and a half right angle  = 1
1

2
 × 90  

      = 
3

2
 × 90 

      = 3 × 45 

      = 135o 

 

(c)  
5

9
 right angles    =  

5

9
 × 90 

   = 5 × 10 

   = 50o 

 

Q5. State whether the following statements are true or false. (Exercise 10.3, page no. 151) 

Sol. a) True 

 b) True 

 c) True 

 d) False 

Q6. Draw two open curves and two closed curves. 

Sol.  

 

   

 

                    Open curves      Closed curves 

 

Note: Students are directed to do the remaining questions of the exercises on 

            fair note book  
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Assignment questions to be done on fair note book: 

 

Q1. Draw a collection of lines which will represent the concurrent lines, parallel lines, 

       intersecting lines. 

Q2. Make a cuboid and measure its each line segment. 

Q3. Draw two simple and two complex curves. 

Q4. How many degrees are there in 
1

3
 right angles and 2

5

6
 right angles? 

Q5. Draw a circle of suitable radius and divide it into six equal parts. What is the measure of     

       each angle formed at the center by each part? 

Q6. If the length of segment AB = 8.7cm, find the length of CD if it is given that CD = 2AB+3. 

Q7. Can a triangle have two right angles? Justify your answer.  
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